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OVERVIEW 

 

Myriad Logging is divided into two main products – Myriad Logging Recorder and Myriad Logging Playback. 

We will refer to these as ‘Logging Recorder’ and ‘Logging Playback’ from now on in this user guide.  

This guide is on the Logging Playback and contains screenshots from v5.6. If you are using a higher version 

the interface may be slightly different. 

There is a separate User Guide on Logging Recorder available at 

www.broadcastradio.com/support/myriad-5-logging-support/documentation/.  

With every Logging Recorder license, you have an unlimited number of Logging Playback licenses to install 

on your machines within your network. This application allows you to see and manipulate the audio and 

data that has been captured by the recorder. This allows for your Sales team along with Production or 

News to take clips from your output for playback or re-use later. 

 

INSTALLATION 

 

Go to http://www.broadcastradio.com/support/myriad-5-

logging-support/myriad-5-logging-downloads/ and 

download the latest full release of the Logging Playback 

software. Once downloaded double click on the .exe file to 

begin the installation.   

Read and accept the Click-Wrap license agreement and 

click on Next.   

Click on Install in the next window. After this is complete 

another window will display, click on Finish. 

There is no license required so this step is not required and 

the application can be run straight after installation.  

On first launch you will be asked for the location of the 

Myriad Logging Catalogue File or the SQL server details. Once this data has been added click on Next. It will 

then ask for which log you would like to open. Choose the desired log and click on Open.  

 

 

 

www.broadcastradio.com/support/myriad-5-logging-support/documentation/
http://www.broadcastradio.com/support/myriad-5-logging-support/myriad-5-logging-downloads/
http://www.broadcastradio.com/support/myriad-5-logging-support/myriad-5-logging-downloads/


THE INTERFACE 

 

The interface of the window is like many audio editors with an overview of the data captured over the last 
48 hours at the top ❶ and a more zoomed in window below ❷. To the right of this window is the date 
and time ❸ of where the playhead currently is. The number of tracks are dependent on what you are 
capturing. In this example we have 3 tracks of metadata - Now Playing, DAB text and Silence information 
and the audio we are capturing is underneath all tracks and shown in the above screenshot in Grey. The 
hashed out area doesn’t contain any audio. Left clicking with the mouse will move the playhead to that 
position and you can tap the spacebar or click on the play icon to hear the audio from that point. 

The data captured is shown in coloured blocks and if you move your mouse cursor over one of the blocks 

the tooltip gives you the information captured. You can see this information displayed in a list view by left 

clicking and dragging up the Metadata Panel ❹ from the bottom of the screen. This reduces the height of 

the tracks.     

The Compilation Panel ❺ enables the mixdown of audio captured by its metadata timestamps or by 

manual selection of in and out points. Compile a list of entries and then ‘Compile’ them to make one audio 

file. 

You can also choose just to set an In and Out point (highlighted in red box above) within your data capture 

and export that as a new audio file. 

  

❺ 



LOG MENU 

 

The Log menu is the only menu in the Logging Playback 

application. The rest are ribbon views which show 

various buttons for specific tasks. 

Select Log enables you to swap between any 

logs/services you have set up within Logging Recorder. 

This does require that you have already connected to a 

Log database or opened a Catalogue File. Which you do 

by using the next menu item. 

Connect to Log Database/Catalogue…  Opens the 

window you saw during first launch and enables you to 

choose between the Catalogue File or an SQL database 

instance. A Catalogue File can be used however is 

designed mainly if you have multiple Logging Recorder 

machines running on your network. If you have only one physical machine doing your logging then for ease 

you should stay with connecting to your SQL database as you would if running Myriad Playout.  

It enables you to select the log you wish to view or connect to another log database or catalogue file. 

All Logs brings up another window showing all logs associated within a Catalogue File. 

Create Listen Again is detailed later in this guide. 

Options – brings up the windows below. General tab enables you to clear the previously opened logs. 

Playback / Export tab allows to you set the playback device and some playback and navigation settings. 

Here you can set the default location of any compilation or exported audio created as well as its audio 

format and how it is titled. Clicking on the  shows the syntax for the auto creation of the exported files 

filename. 

The Pre/post roll tab enables you to change the default durations when a certain type of metadata is 

added to the compilation or exported. 

 

 

 

 

 

 

 

 



Version History shows a webpage with the details of the version you are running and what has changed 

within that version and past versions. 

About shows the exact version number and allows you to click through to the Broadcast Radio support 

website or click to send an email. 

HOME TAB 

 

 

Most of these buttons need no explanation apart from the Nudge Left and Nudge Right buttons. These 

allow you to move within the current view earlier or later in the log. 

The small arrows by the Zoom controls allow you to fully zoom in or out as far as possible in one click. This 

tab is also where you bring up the search window. 

 

VIEW TAB 

 

 

 

 

 

This allows you to change the Interface by showing or removing the Metadata and/or Compilation Panel 

and brings across some of the same options from the Home Tab and a way to centre your view based on 

the play cursor or selection. 

 

SELECTION TAB 

 

 



Enables all types of selection and information on the selection in the timeline. You can fine tune your 

selection area with the Start: and End: timing windows as well as directly export your selection of audio or 

add it to a compilation. 

 

RECENT TAB 

 

Shows the recent logs you have opened and enables you to click on them to open. 

 

METADATA PANEL  

 

 

The panel is at the bottom of the screen. If you can’t see it go to the View Tab and click on Metadata 

Panel. Within this panel are three tabs. Current shows the item where the playhead currently is in the main 

window. Current View shows all the metadata captured within the period of time that is shown in the main 

window as you zoom in and out this list will increase and decrease and the 2 Day View shows all the 

metadata captured over the last 2 days (48 hours) shown in the top zoomed out window. 

You can further refine this list by adding filters to it to perhaps only show the now playing information 

captured or just the silences. 

From this newly filtered list you can click an item or ctrl+click to select multiple entries then right click to 

choose between Playing just those items, Exporting the items to audio files, adding to a compilation with or 

without a pre-roll or just copy the descriptions to plain text for pasting in a document.  



You can find items by name in the box next to the Find 

button or filter the metadata results by type by clicking on 

the Select Filter … bar and adding or removing ticks based 

on the type of metadata you want to show. You can then 

do a further Find within those results. When a result is 

found the playhead will jump to that point in the main 

window and you can choose to play from that point. You 

can also click on the results to jump to that particular point 

in the log. Items can also be dragged from the Metadata 

panel to the Compilation Panel. 

The panel can be made taller or shorter by left clicking just above the three tabs and dragging. This will 

reduce the size of the main window. 

COMPILATION PANEL 

 

A compilation is a selection of audio in and out 

points that you would like as one single file of 

audio. You can add to the compilation list by 

highlighting a portion of the timeline and 

either clicking on the Add to Compilation 

button within the Selection tab or left clicking 

and dragging your selection into the window 

directly. You can also drag events from the 

Metadata panel and Search window. Once you have your selections these can be re-ordered using the up 

and down arrow buttons on the right-hand side of the panel. If you wish to remove an entry, highlight it 

and click on the red X button. You can clear the list using the new list button which is above the red X 

button. 

When you are ready click on the 

Compile button. This will bring up 

the window on the right. You can 

change the output format of the 

audio and when you click on 

Compile will be asked to choose a 

destination for the audio to be 

saved to. A progress bar will go 

across the window and a dialog 

box will display once the audio is 

compiled. You can choose to save 

a .html report of your compilation 

items using the Save Report 

button and using the Open 



Location button will open the destination folder where the audio was saved.  

The Recurrent button brings up 

the recurrent window allow you to 

go back in time and pull out 

certain parts of audio. In this 

example it is pulling out the two 

midday shows it recorded in 

January and the audio length is set 

to 60 minutes. When you click on 

add you can title the name of the 

Source and these will be adding to 

the bottom of the current 

compilation list. 

 

 

  



SEARCHING THE LOG 

 

 

You can search the log for words contained in the metadata captured by clicking on the Home tab and 

choosing the Search Log button. 

You can restrict the search to different timeframes and event types/sub-types. Within the search result you 

can double click on a result to be taken to that exact time and date and the audio will start to play. 

You can also drag search results into the Compilation panel to be added to a mixdown or click on Add to 

Compilation button at the bottom of the search window. 

  



LISTEN AGAIN 

 

This is an additionally licensed feature within Myriad 

Logging Playback and enables you to create a whole show 

for either playback on your station at another time or to 

be used as a podcast file or listen again facility on your 

website or app. 

To start it go to the Log menu and choose Create Listen 

Again. This will load up the main window and if unlicensed 

you will see the message on the right. You can trial the tool 

for 30 times before needing to license it. 

To license go to Settings – License Details… This will bring up the normal licensing wizard and allow you to 

type or paste in your License name and your features code. These are supplied by Broadcast Radio licensing 

team. You can then choose to Obtain a license code over the internet or license over the telephone or 

secure website on another machine which is useful if this machine is not connected to the internet. 

If you have used the Listen Again 

creator before or previously saved 

a configuration you can choose to 

Import Settings… from a config file 

otherwise choose Select Log… to 

bring up the same window you use 

to open the log you wish to work 

with. You can decide, whether or 

not, to use a Database source type 

or, as in this example, a Catalogue 

file. Then choose the Log you wish 

to work with.  

You then set the Start and End 

times and the date from which you 

want to extract the audio. Decide 

which audio format you would like 

the extracted audio to be in and 

the destination/save location of 

this audio once extracted. This can 

be a file on a network or local drive 

or from the dropdown you can 

choose ftp and enter the server 

address and username and 

password if required. 



You can choose to create or append a log file each time this process takes place and you can decide on 

your level of logging with the tick boxes. Once you are happy with your selection click on Create. A progress 

bar will go along to the bottom of the window and when the file is created you will be alerted. 

 

FILE MENU 

 

New enables you to start with a blank window and 

removes any previously inputted or imported settings. 

Open Configuration… Is used to open any .la5 files you 

have on your system. 

Save Configuration and Save Configuration As… enable 

you to save any settings you change within the window so 

they are easily retrievable and able to be used again. This 

will reduce the chance of user error when setting up a 

listen again file creation. 

Create BAT File…  Brings up the window on the right. 

Choose the location using the … button and title the name 

of the batch file. Navigate to the Configuration File and tick 

the appropriate boxes below. By default, the top three are 

ticked and this is normally sufficient. You may need to tick 

the debug box if you are finding problems with the file 

creation process. Click on Create to make your batch file. 

This can then be used in the Windows™ Task Scheduler to 

automate the process of the creation of the files. 

For this to work on an ongoing basis you need to use the 

Current Day or offset from Current Day settings to create a 

variable within the file as it will be running at different days/dates in the future. 

 

HELP MENU 

 

Command line help… brings up a dialog box showing the 

commonly used syntax within a batch file which you can 

hand write or use the Create BAT File.. menu item 

discussed above. 

About Myriad Logging v5 Listen Again Creator… shows the current version and build number of the 

application and gives support website and email details. 

 


